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Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit +clic⌘ Ouvre un menu contextuel

Ctrl (Contrôle)  (Commande)⌘ Utilisé avec d’autres touches

F5 Maj+ +F5⌘ Ouvre le Navigateur

F11 +T⌘ Ouvre la fenêtre Styles & Formatage

La documentation française pour LibreOffice est disponible à :
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et Mac OS X, chacun de
ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner
lieu  à  des options  d’affichage différentes  (polices,  couleurs,  thèmes,  gestionnaire  de fenêtres,
icônes). De plus, ces options d’affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations  de ce chapitre ont  été réalisées sous Windows avec le  jeu  d’icônes  Galaxy.
Certaines  images  ne  ressembleront  donc  pas  exactement  à  ce  que  vous  voyez  sur  votre
ordinateur. En cas de confusion sur une icône, dont l’apparence peut être très différente d’un jeu à
l’autre, vous pouvez vérifier son nom, qui apparaît dans l’infobulle lorsque vous placez le pointeur
de  la  souris  au-dessus.  Pour  modifier  le  style  des  icônes,  sélectionnez  Outils  >  Options  >
LibreOffice > Affichage et dans la section Interface utilisateur choisissez la taille et le style des
icônes.

Introduction

Les images sont souvent utilisées dans les présentations, car elles peuvent véhiculer beaucoup
d’informations  plus  rapidement  qu’un  texte  écrit.  Vous  pouvez  aussi  donner  un  aspect  plus
professionnel à votre présentation en ajoutant le logo d’une société. Vous pouvez aussi vouloir
créer une présentation composée exclusivement d’images, par exemple, pour partager vos photos
de vacances avec vos amis.

Ce chapitre montre comment insérer et mettre en forme des images.

Les images de Gallery

Gallery contient des séries d’images rangées dans des thèmes que vous pouvez utiliser dans une
présentation. Vous pouvez également lui ajouter vos propres thèmes et images, ce qui en fera un
outil  de  base  pour  créer  rapidement  des  présentations.  Gallery  est  disponible  dans  tous  les
composants de LibreOffice.  Pour  vous initier  à Gallery,  voir  le  chapitre 11,  Images,  Gallery et
Fontwork du Guide du débutant.

Gérer la fenêtre Gallery
Pour afficher Gallery, vous pouvez au choix :

• sélectionner le menu Outils > Gallery ;

• cliquer sur le bouton Gallery de la barre d’outils Dessin.

Pour agrandir Gallery, placez le pointeur sur la ligne qui la sépare du haut de l’espace de travail.
Lorsque le pointeur se transforme en lignes parallèles avec flèches, cliquez et tirez vers le bas.
L’espace de travail sera redimensionné en conséquence.

Par défaut, Gallery est ancrée au-dessus de l’espace de travail. Pour la rendre flottante, maintenez
la touche  Ctrl appuyée et double-cliquez dans sa partie haute près des icônes d’affichage. Un
Ctrl+double-clic au même endroit la ramènera à sa position d’ancrage précédente ou par défaut.

Lorsque Gallery est ancrée au-dessus de l’espace de travail, vous pouvez la cacher en cliquant
sur le bouton Afficher / Masquer (cerclé de rouge sur la Figure 1) au milieu de la mince barre la
séparant de l’espace de travail. Le bouton Afficher / Masquer permet de garder ouverte la fenêtre
Gallery pour y accéder rapidement en cas de besoin, tout en libérant sensiblement votre espace
de travail.
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Figure 1 : Gallery avec le bouton Afficher/Masquer cerclé de rouge

Gérer les thèmes de Gallery
Dans Gallery, les objets sont groupés par thème, tels que Puces, Règles, etc. La partie gauche de
la fenêtre Gallery liste les différents thèmes disponibles. Cliquez sur un thème pour voir ses objets
s’afficher dans la partie droite de la fenêtre.

Les thèmes livrés avec LibreOffice sont en lecture seule : aucun objet ne peut y être ajouté ou en
être retranché. Vous reconnaîtrez facilement ces thèmes en cliquant-droit sur leur nom, la seule
option du menu contextuel étant  Propriétés, contrairement aux autres thèmes qui proposent en
outre Actualiser, Supprimer, Renommer.

Dans une installation de base de LibreOffice, la seule catégorie permettant d’ajouter ou retirer vos
propres objets est  Mon Thème.  Vous pouvez aussi créer de nouveaux thèmes pour gérer vos
propres images, comme expliqué page 9.

Ajouter des images issues de fichiers à un thème personnel

Figure 2 : Boîte de dialogue Propriétés d’un thème
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Vous pouvez seulement ajouter des images à Mon thème ou aux thèmes que vous avez créés.

1) Cliquez-droit  sur  Mon  thème  ou  l’un  de  ceux  que  vous  avez  créés  et  choisissez
Propriétés dans le menu contextuel pour ouvrir la boîte de dialogue Propriétés (Figure
2).

2) Cliquez sur l’onglet Fichiers.

3) Cliquez sur  Rechercher des fichiers pour ouvrir la boîte de dialogue de sélection du
chemin d’accès (Figure 3).

4) Rechercher le dossier contenant les images à intégrer.

Figure 3 : Sélectionner un chemin d’accès pour ajouter de nouvelles
images à un thème

5) Cliquez sur OK pour sélectionner les fichiers du dossier, la boîte de dialogue se ferme.
La liste de ces fichiers s’affiche alors dans la boîte de dialogue Propriétés du thème.

6) Sélectionnez les fichiers que vous voulez ajouter au thème et cliquez sur Ajouter. Les
fichiers ajoutés disparaissent de la liste et les images s’affichent dans la fenêtre Gallery.

7) Si vous voulez prendre tous les fichiers de la liste, cliquez sur  Tout ajouter. Tous les
fichiers disparaissent de la liste et les images s’affichent dans la fenêtre Gallery.

8) Quand vous avez fini,  cliquez sur  OK :  la boîte de dialogue  Propriétés du thème se
ferme.

Ajouter des images ou objets par cliquer-glisser
Des images déjà présentes dans un diaporama, ou des objets construits dans Impress ou Draw,
peuvent  être  simplement  ajoutés  à  un thème de  Gallery.  Comme pour  les  images issues de
fichiers, il n’est possible d’ajouter des images que dans les thèmes que vous avez créés ou Mon
thème.

À partir de n’importe quel module :

1) affichez Gallery ;

2) sélectionnez le thème dans lequel vous voulez insérer l’image ou l’objet ;

3) sélectionnez  l’objet  ou  l’image  à  insérer  avec  un  clic  (les  poignées  de  l’objet  sont
visibles) ;

4) cliquez de façon prolongée sur l’objet sans déplacer la souris ; des pointillés esquissant
l’objet  apparaissent  puis  disparaissent  (c’est  le  temps  nécessaire  pour  mettre  en
mémoire l’objet) ;
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5) quand  les  pointillés  disparaissent,  glissez  l’objet  vers  Gallery  et  relâchez-le  dans  le
thème ;

l’objet est alors disponible dans Gallery pour tous les modules.

Retirer des images de Gallery
Vous pouvez seulement retirer des images de Mon thème ou des thèmes que vous avez créés :

1) cliquez-droit sur l’image dans la fenêtre Gallery ;

2) choisissez Supprimer dans le menu contextuel ;

3) un message vous demande de confirmer la suppression de l’objet, cliquez sur Oui.

Note
Si l’image a été insérée à partir d’un fichier, ce qui est supprimé dans Gallery est 
uniquement le lien vers ce fichier, l’original n’est pas supprimé.

Si l’image a été insérée par cliquer-glisser, elle est définitivement supprimée.

Toutes les images de Gallery issues de fichiers sont des liens vers ces fichiers. De temps en
temps,  il  est  utile  de mettre à  jour  le  thème pour  vous assurer  que les fichiers sont  toujours
présents : cliquez-droit sur le thème et choisissez Actualiser dans le menu contextuel.

Ajouter un nouveau thème à Gallery
Vous pouvez insérer de nouveaux thèmes dans Gallery par l’intermédiaire du mécanisme des
extensions,  référez-vous au  chapitre 11,  Installer  et  personnaliser Impress.  Le site  officiel  des
extensions contient une rubrique pour les thèmes de Gallery :
http://extensions.libreoffice.org/extension-center?getCategories=Gallery%20Contents 

Vous pouvez aussi ajouter un nouveau thème à Gallery de la manière suivante :

1) cliquez sur le bouton Nouveau thème… au-dessus de la liste des catégories et la boîte
de dialogue Propriétés s’ouvre ;

2) cliquez sur l’onglet Général et saisissez un nom pour le nouveau thème (Figure 4) ;

3) cliquez  sur  l’onglet  Fichiers et  suivez  les  étapes 3  à  8  du  paragraphe  Ajouter  des
images issues de fichiers à un thème personnel page 7 ;

4) le nouveau thème s’affichera dans la liste des catégories de thèmes dans Gallery.

Figure 4 : Ajouter un nouveau thème à Gallery
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Note
Si vous le souhaitez, vous pouvez renommer ce nouveau thème en cliquant-droit sur 
son nom et en choisissant Renommer dans le menu contextuel.

Insérer des images dans une diapositive

Cette section décrit plusieurs manières d’insérer une image dans une présentation depuis une
source externe. Lorsque l’image est insérée, elle peut être formatée comme décrit plus loin dans
ce chapitre.

Insérer une image à partir d’un fichier
Il est très facile d’insérer une image. D’abord, choisissez une mise en page de diapositive, comme
décrit dans le  Chapitre 1, Introduction à Impress. La plupart des mises en page contiennent des
icônes  pour  insérer  des  objets,  mais  vous  pouvez  insérer  une  image  dans  n’importe  quelle
diapositive.

Que vous utilisiez une mise en page automatique pour l’emplacement d’une image, ou que vous
insériez simplement une image, il suffit de suivre ces étapes :

1) sélectionnez Insertion > Image dans la barre de menu ou cliquez sur l’icône Insérer une
image (Figure 5), la boîte de dialogue Insérer une image s’ouvre (Figure 6) ;

Figure 5 : Icône d’insertion d’objets

Figure 6 : Boîte de dialogue insérer une image
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2) recherchez le dossier contenant l’image à insérer, et sélectionnez le fichier ; LibreOffice
reconnaît  un  grand  nombre  de  types  d’image ;  si  l’option  Aperçu  est  cochée,  une
miniature de l’image choisie sera affichée sur la droite de la boite de dialogue, seulement
si les boîtes de dialogue LibreOffice sont activées :  Outils > Options> LibreOffice >
Général) ;

3) cliquez sur  Ouvrir pour insérer l’image dans la diapositive sélectionnée ; à ce stade,
l’image  est  affichée  sur  la  diapositive,  entourée  de  poignées  de redimensionnement
vertes.

La partie basse de la boîte de dialogue Insertion image comporte une case à cocher Lier, cochez
cette case pour insérer une image comme un lien vers le fichier plutôt que d’incorporer le fichier
lui-même. Il est en général préférable d’incorporer le fichier, la présentation peut ainsi être copiée
et utilisée sur un autre ordinateur. Dans quelques cas cependant, il est plus intéressant de lier
l’image.

• Lorsque  le  fichier  image  est  assez  grand,  lier  plutôt  qu’incorporer  réduira
considérablement la taille du fichier de la présentation.

• Lorsque la même image est utilisée dans beaucoup de présentations. Par exemple, une
image de fond.

• Chaque  fois  que  les  fichiers  liés  seront  disponibles  lors  du  chargement  de  la
présentation.

Insérer une image à partir d’un scanner
Il est normalement assez simple d’insérer une image à partir d’un scanner si les prérequis suivants
sont respectés :

• le pilote logiciel du scanner a été installé sur l’ordinateur ;

• si le système d’exploitation de l’ordinateur est Linux ou autre de type UNIX, le scanner
doit être reconnu par le système SANE ;

• si le système d’exploitation de l’ordinateur est Windows ou Mac OS, le scanner doit être
compatible avec TWAIN.

Pour insérer une image à partir d’un scanner :

1) préparez l’image pour le scanner et assurez-vous que celui-ci est sous tension ;

2) si plus d’un scanner est relié à l’ordinateur, sélectionnez celui que vous désirez par le
menu Insertion > Image > Scanner > Sélectionner la source ;

3) choisissez le menu Insertion > Image > Scanner > Acquérir ;

4) la suite de la procédure dépend du pilote du scanner et de l’interface utilisée ; consultez
la documentation du scanner pour plus d’information ;

5) une fois l’image scannée, elle est affichée sur la diapositive et peut être éditée comme
n’importe quelle autre image.

Insérer une image à partir de Gallery

Choisissez Outils > Gallery dans le menu principal, ou cliquez sur l’icône Gallery  de la barre
d’outils Dessin pour ouvrir le panneau Gallery (Figure 7).

1) Sélectionnez un thème dans le volet gauche, puis recherchez dans le volet droit l’image
qui vous convient.

2) Cliquez sur l’image et faites-la glisser dans l’espace de travail.

3) Relâchez le bouton de la souris et l’image sera déposée sur votre diapositive. Si néces-
saire, redimensionnez-la comme indiqué dans Redimensionner une image, page 16.
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Figure 7 : Insérer une image à partir de Gallery

Copie et collage
Copier  une  image  puis  la  coller  est  une  autre  façon  d’incorporer  des  images  dans  votre
présentation, qui passe par le presse-papiers. L’image copiée peut être une image déjà incorporée
dans un autre document, ou ce peut être un fichier image.

Après la copie, vous pouvez choisir le format dans lequel vous voulez coller l’image dans Impress
en choisissant  Édition > Collage spécial depuis  la  barre de menus.  Les formats disponibles
dépendent du type d’image copiée dans le presse-papiers.

Exporter des images

Exporter le fichier entier
Par défaut, Impress enregistre les présentations au format ODP, mais certains logiciels ne peuvent
pas ouvrir ces fichiers. Vous pouvez alors exporter le fichier dans divers formats.

1) Dans votre présentation, ne sélectionnez aucun objet et choisissez Fichier > Exporter
depuis la barre de menus. La boîte de dialogue Exporter s’ouvre (Figure 8).

Figure 8 : Exporter un document Impress
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2) Sélectionnez le format désiré dans la section supérieure de la liste déroulante Format de
fichier.

3) Cliquez sur Exporter.

4) Selon  le  format  sélectionné,  une  autre  boîte  de  dialogue  peut  s’ouvrir  pour  vous
demander de spécifier les options nécessaires à ce format graphique.

5) Cliquez sur Exporter, Créer ou OK et votre document sera exporté en tant que nouveau
fichier dans un nouveau format.

Note
Les formats situés dans la section supérieure de la liste déroulante Format de fichier 
(HTML, XHTML, PDF et SWF) ne s’appliquent qu’à des documents entiers.

Exporter des objets
Pour exporter des objets individuels de votre document :

1) Dans  votre  dessin,  sélectionnez  les  objets  que  vous  voulez  exporter  et  choisissez
Fichier > Exporter depuis la barre de menus. La boîte de dialogue Exporter s’ouvre
(Figure 8).

2) Sélectionnez le format désiré dans la section inférieure de la liste déroulante Format de
fichier.

3) Cochez l’option Sélection.

4) Cliquez sur Exporter.

5) Selon  le  format  sélectionné,  une  autre  boîte  de  dialogue  peut  s’ouvrir  pour  vous
demander de spécifier les options nécessaires à ce format graphique.

6) Cliquez sur  Exporter,  Créer ou  OK et les objets sélectionnés seront exportés en tant
que nouveau fichier  dans un nouveau format.  Les images seront  exportées avec les
filtres que vous leur avez appliqués dans le document (rognage…).
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Enregistrer des images
Vous pouvez enregistrer une image d’origine (sans les filtres que vous lui avez appliqués dans le
document comme le rognage) contenue dans votre présentation en tant que fichier individuel. Pour
ceci :

1) Sélectionnez  l’image  que  vous  voulez  enregistrer,  faites  un  clic  droit  et  choisissez
Enregistrer l’image dans le menu contextuel.  La boîte de dialogue Export  d’images
s’ouvre (Figure 9).

Figure 9 : Boîte de dialogue Export d’images

2) Spécifiez le nom du fichier dans la zone Nom de fichier.

3) Choisissez le format d’image dans la liste déroulante Type de fichier.

4) Cliquez sur Enregistrer pour enregistrer l’image en tant que nouveau fichier.

Mettre en forme des images

Cette section traite de la mise en forme des images insérées à l’aide de l’une des méthodes
détaillées dans la section Insérer des images dans une diapositive, page 10.

Taille d’origine
Réinitialise  les  dimensions  de  l’image  avec les  valeurs  telles  qu’elles  étaient  définies  lors  de
l’insertion de l’image.

Nom
Il est recommandé de renommer les images en utilisant Modifier > Nom depuis la barre de menus
ou  en  faisant  un clic  droit  et  en  choisissant  Nom dans  le  menu contextuel.  Seuls  les  objets
nommés sont visibles dans le Navigateur et peuvent être importés directement depuis un autre
fichier.
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Description
Vous  pouvez  ajouter,  en  tant  que  métadonnées,  un  titre  et  une  description  à  l’image.  Cette
information est utilisée par les outils d’accessibilité (comme un logiciel de lecture d’écran) et en
qualité d’attributs de type ALT (alternatifs) si vous exportez le document en HTML.

Compresser une image

Figure 10: Boîte de dialogue Compresser l'image

Vous pouvez jouer sur le taux de compression et/ou la résolution des images afin de minimiser leur
impact sur la taille du fichier de la présentation :

1) Cliquez droit sur l’image et choisissez Compresser l’image ;

2) La boîte de dialogue de la Figure 10 s’ouvre ;

3) Choisissez la qualité de compression ou la résolution ;

4) Vérifiez l’impact sur la qualité de l’image à l’aide du bouton Calculer, la nouvelle qualité
est affichée au-dessus du bouton ;

5) Pour valider votre choix, cliquez sur OK.

Attention Une résolution ou une qualité de compression trop faible risque d’affecter l’affichage 
de l’image en plein écran. Il faudra donc faire un compromis entre la qualité des 
images et la taille du fichier final.

Édition avec un outil externe
Vous pouvez éditer  une image avec un outil  externe,  afin  de disposer  de fonctionnalités plus
avancées. Pour ceci, sélectionnez l’image, faites un clic droit et choisissez Éditer avec un outil
externe dans le menu contextuel.
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Déplacer une image
1) Cliquez sur l’image pour la sélectionner et des poignées vertes s’affichent.

2) Si nécessaire, déplacez le pointeur de la souris jusqu’à ce qu’il change de forme. La
forme du pointeur dépend du système d’exploitation, par exemple une quadruple flèche
ou une main.

3) Cliquez et faites glisser l’image vers l’emplacement choisi.

4) Relâchez le bouton de la souris.

Pour  positionner l’image avec plus de précision,  utilisez la  boîte de dialogue  Position et  taille
décrite dans le Chapitre 6, Mettre en forme des objets graphiques.

Astuce

Pour déplacer avec précision une image ou un objet, utilisez les flèches de direction.

• Flèches : déplacement d’1 mm.

• Maj+flèches : déplacement d’1 cm.

• Alt+flèches : déplacement d’1 pixel ; le déplacement dépend donc du zoom.

Redimensionner une image
1) Cliquez sur l’image pour afficher les poignées vertes.

2) Déplacez le pointeur sur l’une des poignées, vous remarquez que son aspect change
pour indiquer la direction dans laquelle le cadre sera redimensionné.

3) Cliquez et faites glisser pour redimensionner l’image.

4) Relâchez le bouton de la souris, lorsque la nouvelle taille vous convient.

Pour redimensionner l’image avec plus de précision, utilisez la boîte de dialogue Position et taille
décrite dans le Chapitre 6, Mettre en forme des objets graphiques.

Note
Les poignées d’angle modifient simultanément les deux dimensions du cadre, alors 
que les poignées sur les côtés modifient seulement une dimension.

Astuce
Pour conserver l’échelle de l’objet, maintenez appuyée la touche Maj, cliquez sur 
l’une des poignées d’angle et faites glisser. Attention de ne pas relâcher la touche 
Maj avant le bouton de la souris.

Attention Sachez que retravailler une image tramée peut en affecter la résolution en produisant
un certain flou. Il vaut mieux redimensionner une image avec un logiciel spécialisé tel
que Gimp avant de l’insérer dans votre présentation (http://www.gimp.org/).

Faire pivoter une image
Comme pour le placement d’une image sur la page, sa rotation peut-être faite manuellement ou à
l’aide d’une boîte de dialogue spécialisée. Cette boîte de dialogue est décrite dans le Chapitre 6,
Mettre en forme des objets graphiques.

Faites pivoter une image de la manière suivante :

1) sélectionnez l’image pour afficher les poignées vertes ;

2) cliquez sur l’icône Tourner  de la barre d’outils  Image et les poignées de sélection
deviennent rouges (Figure 11) ;
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Figure 11 : Faire pivoter une image

Note

Les icônes représentant les fonctions dans les barres d’outils dépendent du système 
d’exploitation, de la façon dont il a été configuré et de la personnalisation de 
LibreOffice. En cas de doute, faites survoler l’icône par la souris et attendez 
l’affichage de l’infobulle indiquant le nom du bouton.

3) un  cercle  avec  viseur  (dépendant  du  système  d’exploitation)  apparaît  au  centre  de
l’image indiquant le point de rotation ; par défaut, l’image tourne autour de son centre,
mais ce point de rotation peut être déplacé sur un angle et même en dehors de l’image ;
pour cela, cliquez sur le point de rotation et faites-le glisser jusqu’à l’endroit désiré avant
d’effectuer la rotation ;

4) dans chaque angle de l’image, il y a une poignée de rotation et la forme du pointeur
change lorsqu’il passe au-dessus de l’une d’entre elles ; cliquez et pivotez l’image dans
la direction que vous souhaitez ;

5) relâchez le bouton de la souris.

Astuce

Vous pouvez forcer l’angle de rotation à des multiples de 15 degrés en maintenant la 
touche Maj appuyée pendant la rotation. C’est très pratique pour effectuer des 
rotations à angle droit, par exemple pour passer du format Portrait au format 
Paysage.

Mettre en forme à l’aide de la barre d’outils Image
Lorsqu’une image est sélectionnée, la barre d’outils Image devient accessible. Cette barre d’outils
fournit un certain nombre d’options de formatage décrites dans cette section. Si la barre d’outils
Image n’apparaît  pas lorsqu’une image est sélectionnée,  affichez-la à l’aide du menu principal
Affichage > Barres d’outils > Image (Figure 12).

Figure 12: Barre d’outils Image
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Appliquer des filtres

Utilisez  l’icône  Filtrer  sur  la  barre  d’outils  Image  pour  appliquer  divers  filtres  à  l’image
sélectionnée. Le meilleur moyen de juger de l’effet d’un filtre sur une image est de l’essayer :

1) sélectionnez l’image de façon à faire apparaître les poignées vertes ;

2) cliquez sur l’icône Filtrer pour voir les différents filtres disponibles ; le  Tableau 1 décrit
brièvement chacun des filtres et leurs effets, pour plus de détails, consultez le chapitre 6
(Éditer des images) du guide Draw ;

3) sélectionnez le filtre que vous désirez appliquer ; pour connaître le nom du filtre, survolez
son icône avec le pointeur de la souris et attendez l’apparition de l’infobulle ;

4) si vous n’êtes pas satisfait de l’effet obtenu, ou si vous voulez essayer un autre filtre,
cliquez sur l’icône  sur la barre d’outils Standard ou pressez Ctrl+Z.

Tableau 1 : Filtres d’image

Icône Nom Effet

Invertir
Inverse les couleurs d’une image, ou la luminosité si elle est en 
niveaux de gris.

Adoucir
Adoucit ou estompe l’image par l’application d’un filtre de basse 
fréquence.

Augmenter la 
netteté

Augmente la netteté de l’image par l’application d’un filtre de 
haute fréquence.

Supprimer les 
interférences

Élimine le bruit en appliquant un filtre médian.

Solarisation
L’effet qui donne l’impression d’une lumière trop élevée pendant 
le développement d’une photo. Ouvre une boîte de dialogue.

Vieillissement
Tous les pixels sont placés à leurs valeurs grises, puis les canaux
vert et bleu sont réduits. Le canal rouge reste inchangé.

Poster
Cet effet réduit le nombre de couleurs. Ainsi, les photos 
ressemblent à des peintures. Ouvre une boîte de dialogue.

Pop-Art Convertit une image dans un style pop-art.

Dessin au fusain
Affiche l’image comme un croquis au fusain. Les contours de 
l’image sont tracés en noir et les couleurs sont supprimées.

Relief
Une source de lumière imaginaire détermine le type d’ombre et 
l’apparence de l’image en relief. Affiche une boîte de dialogue.

Mosaïque
Rassemble de petits groupes de pixels en zones rectangulaires 
de la même couleur.

Changer de mode graphique
Utilisez la liste déroulante de la barre d’outils Image (Figure 12) pour changer de mode graphique.
Vous disposez des options suivantes :

• Par défaut : pas de changement appliqué à l’objet graphique ;

• Niveaux de gris : l’image est convertie en niveaux de gris ;

• Noir/Blanc : chaque pixel de l’image est converti en noir ou blanc selon sa luminosité ;

• Filigrane : règle la luminosité de l’image pour permettre de l’utiliser comme filigrane.
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Astuce
Si vous devez imprimer votre document sur une imprimante noir et blanc, utilisez le 
mode niveau de gris pour visualiser le rendu sur papier.

Régler la couleur

Cliquez sur l’icône  Couleur  dans la barre d’outils  Image (Figure 12),  la boîte de dialogue
Couleur (Figure 13) s’ouvre pour régler les couleurs de l’image.

Figure 13 : Réglage des couleurs

Cette boîte de dialogue permet de modifier les couleurs primaires de l’image (rouge, vert, bleu)
ainsi que sa luminosité, son contraste et son gamma. Si le résultat ne vous convient pas, pressez
Ctrl+Z pour restaurer les valeurs originales.

Pour mettre une image en arrière-plan ou en filigrane, il vaut mieux augmenter son gamma, car
elle interférera moins avec un texte foncé.

Régler la transparence de l’objet

Modifiez le pourcentage dans la boîte Transparence  sur la barre d’outils Image (Figure
12)  pour  rendre l’image plus  transparente.  Notez que cette  opération  diffère  des réglages de
transparence d’un objet ligne ou forme décrits dans le Chapitre 5, Gestion des objets graphiques.
Comme pour le réglage du gamma, augmenter la transparence d’une image lui permet de mieux
se fondre dans l’arrière-plan, rendant le texte superposé plus facile à lire.

Régler la ligne, le remplissage et l’ombre

Ces réglages ne sont pas très utilisés pour les images, à l’exception de l’icône Ombre . La
ligne permet d’ajouter un cadre à l’image. Le remplissage définit l’arrière-plan qui contient l’image,
et non l’image elle-même. Pour voir cet arrière-plan, vous devez fixer la valeur de transparence de
l’image à un niveau suffisamment élevé.

Recadrer des images
Impress propose deux manières de recadrer une image : interactivement ou par l’intermédiaire
d’une boîte de dialogue. La méthode interactive est plus simple à utiliser, mais la boîte de dialogue
permet  une  intervention  avec  davantage  d’options.  Vous  pouvez  utiliser  les  deux  méthodes :
recadrer d’abord interactivement, puis régler plus finement avec la boîte de dialogue.

Pour recadrer interactivement une image sélectionnée, cliquez sur l’icône Rogner l’image  sur
la barre d’outils  Image (Figure 12).  Un ensemble de poignées de rognage apparaît  autour de
l’image (Figure 14).

Figure 14 : Marques de recadrage
interactif
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Lorsque le pointeur de la souris passe au-dessus de l’une des marques de recadrage, il change de
forme. Cliquez sur la marque et faites glisser pour recadrer l’image. Cliquez hors de l’image pour
quitter le mode recadrage.

Pressez Maj tout en manipulant les marques de recadrage.

• Pour une marque d’angle, l’image conservera ses proportions et sera recadrée et ancrée
sur la marque de l’angle opposé.

• Pour une marque latérale, l’image conservera ses proportions et sera recadrée et ancrée
sur la marque du côté opposé.

Avec cette méthode, par défaut l’échelle est conservée.

Figure 15 : Boîte de dialogue pour recadrer l'image

Pour recadrer avec la boîte de dialogue, cliquez-droit sur une image sélectionnée et choisissez
Rogner l’image dans le menu contextuel, ou choisissez Format > Rogner l’image dans le menu
principal. La boîte de dialogue Rogner (Figure 15) propose alors les options ci-dessous.

• Conserver l’échelle/la taille de l’image : avec la valeur par défaut (conserver l’échelle),
l’échelle de l’objet reste constante lors du recadrage. Lorsque la case Conserver la taille
de  l’image  est  cochée,  le  rognage  provoque  un  agrandissement  (pour  les  valeurs
positives), une réduction (pour les valeurs négatives), ou une distorsion de l’image pour
que la taille reste constante.

• Gauche, Droit, Haut et Bas : la fonction de ces boîtes change en fonction de l’option ci-
dessus.  Dans  les  deux cas,  lorsqu’une  valeur  est  donnée  dans  une  de  ces  boîtes,
l’image est  rognée de cette  valeur.  Par  exemple,  une valeur  de 3 cm dans la  boîte
Gauche, ôtera 3 cm au côté gauche de l’image.

• Lorsque la case Conserver l’échelle est sélectionnée, la taille de l’image change aussi,
ainsi dans cet exemple, la largeur sera réduite de 3 cm. Si la case Conserver la taille de
l’image est sélectionnée, la partie restante de l’image est agrandie (valeurs de rognage
positives) ou réduite (valeurs de rognage négatives) de telle manière que la largeur et la
hauteur de l’image restent inchangées.

• Remarquez  que  dans  ce cas  les  champs  Largeur et  Hauteur de  la  section  Échelle
varient. Utilisez l’aperçu à droite pour régler le rognage à la valeur qui vous convient.

• Échelle Largeur/Hauteur : indiquent en pourcentage l’échelle de l’image. La taille de
l’image varie selon ces valeurs.

• Taille de l’image Largeur/Hauteur : indiquent la taille de l’image dans l’unité de mesure
choisie dans les options générales d’Impress. L’image s’agrandit ou se réduit selon ces
valeurs.
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• Taille d’origine :  ce bouton permet de restaurer la taille initiale de l’image. Très utile
pour restaurer une image après de multiples transformations.

Toute opération de rognage ne change que l’affichage de l’image.  L’image d’origine n’est  pas
modifiée. Si vous voulez exporter une image rognée, vous devez le faire en utilisant  Fichier >
Exporter. Si vous choisissez Enregistrer l’image dans le menu contextuel, c’est l’image d’origine
qui sera exportée.

Remplacer des couleurs
L’outil  Remplacement de couleurs vous permet  de modifier  une couleur  d’une image,  de la
remplacer par une autre couleur ou de la rendre transparente. Jusqu’à quatre couleurs peuvent
être remplacées en même temps. L’outil  fonctionne sur l’image entière et vous ne pouvez pas
sélectionner une partie de l’image pour l’éditer.

L’outil  Remplacement de couleurs ne peut être utilisé qu’avec des images incorporées. Si vous
essayez d’utiliser cet outil avec une image liée, lorsque vous cliquez sur le bouton Remplacer, le
message suivant s’affichera :

La  liste  de  sélection  Remplacer  par contient  toutes  les  couleurs  disponibles  de  la  palette  de
couleurs en cours pour le document. Vous ne pouvez pas ici définir de nouvelles couleurs, mais
vous pouvez ajouter des couleurs à cette palette avant d’utiliser l’outil.

Pour remplacer des couleurs dans une image, faites comme suit :

1) Sélectionnez  Outils  >  Remplacement  de couleurs depuis  la  barre  de menus pour
ouvrir la boîte de dialogue Remplacement de couleur (Figure 16).

2) Sélectionnez l’image où remplacer des couleurs.

3) Cliquez sur l’icône Pipette  pour activer le mode de sélection de couleur.

4) Déplacez le pointeur de la souris au-dessus de la couleur à remplacer dans l’image et
cliquez.

5) Une case est cochée dans la liste des couleurs et la couleur sélectionnée apparaît dans
la zone Couleur d’origine.

Figure 16 : Remplacement de couleurs
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6) Saisissez le pourcentage de tolérance par rapport à la couleur sélectionnée. La valeur
par défaut est de 10 %.

7) Dans la  zone  Remplacer par,  sélectionnez la couleur de remplacement dans la  liste
déroulante. La valeur par défaut est Transparent.

8) Vous  pouvez  répéter  les  étapes  3  à  7  pour  remplacer  jusqu’à  quatre  couleurs
simultanément.

9) Cliquez sur le bouton Remplacer pour procéder au remplacement.

Il n’existe pas d’aperçu de l’effet produit par l’outil de remplacement de couleurs. Si le résultat ne
correspond pas à vos attentes, faites Édition > Annuler et recommencez.

Le pourcentage de tolérance est  utilisé  pour  indiquer  combien de valeurs de couleurs  seront
remplacées. Plus ce pourcentage sera faible, plus les couleurs devront être proches de la valeur
de couleur sélectionnée pour être remplacées.

Vous pouvez également remplacer la valeur de couleur Transparent par une autre valeur dans une
image. Pour ceci, faites Outils > Remplacement de couleurs, puis sélectionnez l’image. Dans la
boîte de dialogue Remplacement de couleur, cochez la case Transparence, puis sélectionnez la
couleur de remplacement dans la liste déroulante. Cliquez alors sur le bouton Remplacer.

Supprimer une image
1) Cliquez sur l’image pour faire apparaître les poignées de sélection vertes.

2) Pressez la touche Suppr.

Créer une Image Map

Une Image Map définit des zones de l’image (zones de référence, en anglais hotspots) associées
à une URL (adresse web ou fichier sur l’ordinateur).  Ces zones de référence sont l’équivalent
graphique des hyperliens. Cliquer sur une zone de référence force Impress à ouvrir la page liée
dans le programme qui convient (par exemple, le navigateur par défaut pour les pages HTML ;
LibreOffice Writer pour les fichiers ODT ; la visionneuse PDF pour des fichiers PDF).

Vous pouvez créer des zones de référence de diverses formes : rectangles, ellipses, et polygones.
Vous pouvez aussi  inclure  plusieurs zones de référence dans la  même image.  Lorsque vous
cliquez sur une zone de référence, l’URL s’ouvre dans la fenêtre ou le cadre du navigateur que
vous avez spécifié.  Vous pouvez aussi définir  le texte qui apparaîtra lorsque le pointeur de la
souris survolera la zone.

Pour ouvrir l’Éditeur d’Image Map pour créer ou éditer une Zone de référence :

1) sélectionnez l’image où vous voulez définir des zones de référence ;

2) choisissez  Édition  >  Image  Map dans  le  menu  principal  et  l’Éditeur  d’Image  Map
s’ouvre.  (Figure  17) ;  la  partie  principale  de la  boîte  de dialogue  affiche l’image sur
laquelle les zones de référence seront définies ;

3) la zone de référence sélectionnée est encadrée par huit points verts ;

4) utilisez les outils et les champs en haut de la boîte de dialogue pour définir les zones de
référence et leurs liens, cf. ci-dessous ;

5) cliquez sur l’icône Appliquer  pour affecter les paramètres à l’image ;

6) lorsque vous avez terminé, cliquez sur l’icône Enregistrer  pour sauvegarder l’image
Map dans un fichier,  puis cliquez sur l’icône de fermeture (généralement un X) dans
l’angle en haut à droite pour fermer la boîte de dialogue.
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Figure 17 : Boîte de dialogue éditeur d'Image Map

La partie haute de la boîte de dialogue contient, de gauche à droite, les outils suivants :

• Appliquer : cliquez sur cette icône pour appliquer les modifications réalisées ;

• Ouvrir, Enregistrer, et Sélectionner ;

• Rectangle,  Ellipse,  Polygone,  et  Polygone  à  main  levée :  ces  outils  servent  à
dessiner  la  forme de la  zone de référence,  ils  fonctionnent  exactement de la  même
manière que leurs correspondants dans la barre d’outils Dessin, décrits dans le Chapitre
5, Gestion des objets graphiques ;

• Éditer, Déplacer, Insérer, Supprimer des points : sont des outils évolués pour modifier
la  forme d’une zone de référence de type polygone ;  sélectionnez l’outil  Éditer  des
points pour activer les autres ;

• Actif :  fait  passer une zone de référence sélectionnée de l’état actif  à inactif  et vice-
versa ;  la  bordure  des  zones  actives  est  noire,  alors  que  celle  des  zones  inactives
devient rouge ; un clic sur une zone déclarée inactive n’entraînera pas l’ouverture de la
cible du lien correspondant ;

• Annuler et Rétablir ;

• Macro : associe une macro à la zone de référence en lieu et place de l’hyperlien ;

• Propriétés : cliquez sur cette icône pour modifier les propriétés de l’hyperlien et de lui
attribuer un nom et une description ;

• Au-dessous de la barre d’outils se trouvent trois champs pour saisir les propriétés de la
zone de référence :

– Adresse : saisir l’adresse URL sur laquelle pointe un hyperlien ; vous pouvez aussi
pointer sur une ancre dans un document, par exemple un numéro de diapositive, pour
cela, écrivez l’adresse dans le format suivant :
file:///<chemin>/nom_du_document#nom_de_l’ancre ;

– Texte : saisir le texte à afficher lors du survol de la zone de référence par le pointeur
de la souris ;

– Cadre :  définir  où la  cible de l’hyperlien doit  s’ouvrir ;  _blank (ouvre une nouvelle
fenêtre  du navigateur) ;  _self,  c’est  la  valeur  par  défaut,  ouvre  la  cible  dans  une
fenêtre active ; _top ou _parent.
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Astuce
La valeur _self pour un cadre cible fonctionnera dans la grande majorité des cas. Il 
n’est pas recommandé d’utiliser les autres options sans absolue nécessité.
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